Note:  Tips with (DG) after the name were found on Dave Gerber’s website www.davebytes.com  In addition to being a radio show host, Dave is an APCUG Advisor for Region 5 (Florida) and a Vice President of the Sarasota PCUG.

GENERAL COMPUTER / WINDOWS TIPS

Use WinXP's Taskbar Address Bar (DG)

Many users overlook WinXP's ability to keep an open Address bar in the Taskbar. Right-click the Taskbar, select the Toolbars menu, and click Address. This will add an Address bar to your Taskbar that looks and acts like the Internet Explorer Address bar. If the full bar is not visible, just double-click Address to expand it. You can type in URLs to launch the browser directly into this destination. If you have several IE windows open, the Taskbar Address bar will control the window in the foreground.

Windows XP and speech recognition (DG)

Strictly speaking, speech recognition isn’t part of Windows XP. However, some computer manufacturers install Microsoft’s speech recognition software with XP. This software will turn spoken words into text. You can also execute commands by voice.

To find out if the speech software is on your computer, click Start + Control Panel. Then double-click the Speech icon. If there’s a Speech Recognition tab, it’s already installed. You can “train” the software from this dialog box. For more on “training,” keep reading.

If it isn’t on your computer, you have two options. First, you can buy Microsoft Plus! for Windows XP. You’ll find this at your local computer store for about $30.

Your other choice is to purchase Microsoft Office or Microsoft Word. The version you need is XP (2002) or 2003. Of course, Word and Office are both pricey. A full version of Word is about $200. Full versions of Office start around $400. If you’re a student or teacher, look for the Academic version of Office. It’s about $150. Learn more from Microsoft.

To make matters more confusing, Office and Word don’t always install speech recognition. You must opt to install it.

To install the speech recognition component in Word, click Tools +Speech. Click Yes when asked if you want to install the speech software. Have your Office/Word disk handy. You’ll probably be prompted to insert it.

If Speech isn’t on the Tools menu, you must use your Office/Word disk. Select Add or Remove Features and click Next. Then click “Choose advanced customization of applications” and click Next. Click Office Shared Features Alternative User Input. Click the arrow beside Speech and select “Run from My Computer.” Click Update.

After the installation is complete, click Tools +Speech to “train” the software. You will be given a passage to read. This will help it learn your particular speech patterns and pronunciation. A profile must be created for each user on the computer.

When you train the software, speak as you normally would. Over or under enunciation will cause problems. I know someone who read the passage as if he were reading to a child. It was not successful.

Keep in mind that speech recognition is far from perfect. You’ll have to make lots of corrections at first. But you can do more training with the software to increase accuracy.

Also, you need a good microphone. Get the noise-canceling headset type. Expect to pay about $30. And read the packaging. It will say if it’s suitable for speech recognition.

Microsoft recommends at least 128MB of RAM and a 400MHz computer. This is the bare minimum. Speech recognition uses a lot of computing power. Make sure your computer can handle it. I recommend a minimum 512MB of RAM and 1.5MHz processor.

Displaying the Traditional Desktop Icons (DG)

Older versions of Windows had a few icons that always appeared on the desktop: 

My Documents

My Computer

My Network Places

Internet Explorer

Recycle Bin 

Of these five, only the Recycle Bin appears on the Windows XP desktop by default. If you want to display any of the other icons, follow these steps: 

Right-click anywhere on the desktop. Make sure you right-click the desktop itself, not on an object lying on the desktop. Windows displays a context menu. 

Choose Properties. The Display Properties dialog box springs into view. 

On the Desktop tab, click the Customize Desktop button. Windows displays the Desktop Items dialog box with the General tab selected. 

At the top of the dialog box, select the check boxes corresponding to the icons you want displayed on the desktop. Conversely, you can deselect the check boxes of any icons you don't want displayed. 

Keep clicking OK to dismiss all the dialog boxes onscreen. 

The icons you selected should be visible onscreen, along with all the others you have. 

Burning Pictures On a CD (DG)

Do you have about a hundred gazillion pictures on your PC eating up hard disk space? If you have a CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, or DVD+RW drive, burning those pictures onto a CD, where they'll last for decades, is very easy. A CD certainly lasts longer than your hard drive, providing you don't gum it up with one of those sticky CD labels. 

Burning pictures couldn't be simpler: 

Make sure that your CD-R, CD-RW, DVD-R, or DVD-RW drive is installed and working. 

Start Windows Explorer. (Just choose, say, Start, My Pictures or Start, My Computer.) 

Navigate to the pictures you want to burn. If you're in a picture or photo album folder, Copy to CD appears in the Picture Tasks list. 

Select the picture(s) you want to burn; then click Copy to CD in the Picture Tasks list. If Copy to CD doesn't appear in the list, right-click one of the selected files (or folders) and choose Send To, CD Drive. A small CD icon appears in the notification area, next to the clock. 

Keep moving around Windows, gathering pictures that you want to burn. In spite of what the Picture Task list and right-click menu say, Windows actually copies the files you select to a staging area -- a place on your hard drive that holds files temporarily, before you burn them to CD. 

When you're done gathering files, choose Start, My Computer, your CD burner drive (whichever drive letter that is). Windows shows you the contents of the CD's staging area. 

Put a recordable CD in your CD burner and click Write These Files to CD. The CD Writing Wizard appears. 

Type the name you want to be burned on the CD; then click Next. If you've chosen too much data -- too many pictures -- the wizard alerts you. 

If you have too many pictures selected, don't do anything with the wizard. Instead, go back to the staging area and start deleting files or folders (right-click and choose Delete) until you're under the size limit. Don't worry -- you aren't deleting the pictures. You're just removing them from the staging area. Unfortunately, neither the wizard nor Windows offers a handy list of folder sizes or suggestions for what to trim. What you can do is right-click a folder, choose Properties, and see the folder's size. 

When you think that you've deleted enough files or folders,go back to the wizard,click Retry Writing the Files to CD Now, and then click Next. 

If you still have too many pictures selected, you get the warning again. Sooner or later, you have your picture collection trimmed down to the point where it can fit on the CD. At that point, the wizard starts writing files to the CD. Depending on the speed of your burner, it can take 20 minutes or more to burn a full CD. 

When the wizard finishes, click Finish. The wizard removes all the files from the staging area. 

Immediately try looking at the pictures on the CD. 

Chances are very good that they're in excellent shape. Oh, and don't forget to label the CD with a Sharpie marker. 

Making Your Multimedia Editing Programs Run Faster (DG)

Everything these days is digital -- digital video cameras, digital still-shot cameras, digital audio recorders, digital mixers, and so on. All that digital equipment stores tons of information and can plug into your computer. Everyone wants to store, edit, play, and share all that digital information. New software is appearing all the time, promising the ability to slice and dice multimedia information 12 ways to Sunday.

The problem with having all that digital information on your computer, of course, is that the files created for digital multimedia are huge, huge, huge! Many things can affect the size of multimedia files, including quality, resolution, and audio or video speed. CD-quality audio can take 50KB of disk space per second. Video throws the storage needs through the roof: every second of video can require 6MB of file space. That is huge!

Say that you shoot two hours of digital video of your parents' 50th anniversary. You get everything -- the grand entrance, the arrival of the siblings, the arrival of your aunts and uncles, the arguments, the food fight. Hmmm... Let's see; that's 7,200 seconds, or anywhere from 36 to 44GB of data. Ack! Just for a single event!

As you can imagine, programs that allow you to fold, spindle, mutilate, and otherwise process such huge files can place quite the burden on your computer system. Top-notch programs push the envelope, trying to squeeze all the performance out of your system that they can.

The following points are the best two ways to speed up those programs:

Make sure you have lots and lots and lots of RAM in your computer. The more memory you can install, the better. If your motherboard can handle it, install 1GB or more of RAM. Windows XP can handle the added memory just fine, and the addition helps with editing Mom and Dad's anniversary party, so it doesn't show when Uncle Joe showed up with his walker and his surprise twenty something bride.

Make sure you're using the fastest video card you can, along with a fast hard drive designed for multimedia use. Yes, they do make hard drives just for multimedia use. If you have one of these babies, you won't be sorry when it comes time to doing gymnastics with gigabytes of data.

Stop Printing that Document (DG)

Sometimes you begin to print a document and then change your mind. How do you stop a print job? Because your program simply passes off its printing jobs to Windows, there is no obvious way to cancel printing. It can be done if you're crafty, however. Follow these steps: 

Locate the printer icon located on the taskbar at the bottom-right of your screen. (Look near the current-time display.)  This printer icon appears only when Windows is sending something to the printer. Depending on how much you're printing and how fast your printer is, you may not even see it at all. If you don't, you're out of luck and you may as well quit right now and eat some ice cream. 

Double-click the little printer icon. 

Click the name of your document "job" in the Print Manager's list. 

Choose Document-->Cancel Printing. 

You may be asked whether you really want to terminate the employee, er, print job. Click OK. If you're using a network printer, you may not be able to cancel the document. Oh well. 

Choose Printer-->Close. You are zapped back to your program, ready for more editing action. 

Killing a Window (DG)

Have you ever had one of those windows that misbehave? By "misbehave," I mean you cannot get it to Maximize or Minimize. Sometimes Web programmers want to splash a screen onto your PC with no controls and will use this technique so that you can't get their junk off your screen. For some bizarre reason they think this is a good thing. Anyway, you do have some control with the standard Windows window control options. 

Click anywhere in the misbehaving window and hit Alt + Spacebar. 

On the resulting menu, you can choose Close and kill the window.

Getting Rid of Preinstalled Software (DG)

One of the things (among many) that drives a lot of computer users crazy is preloaded software. You buy a computer from Dell, Gateway, or any number of other retailers, and they throw in a boatload of software, already installed on the computer. The problem is that most of the software is of very little value. Sometimes all of the software is of no value. It's easy to fill up a computer with no-value software and tout what a great deal you're getting. Hogwash!

Did your computer come with lots of software preinstalled? If so, take a few minutes to figure out how much of it you actually use. Take a look at what was installed when you got your system and add the unused software to your list of removal targets. Don't worry; removing preinstalled software won't make your computer stop working, void your warranty, or subject you to criminal prosecution. (Unlike that stupid little tag on mattresses that you might still be afraid to remove.)

How to Find out What Programs are Installed on your Computer (DG)

Here's an easy way to get a list of all the Microsoft programs that are installed on your computer: 

Click Start | Help and Support. 

In the left column of the Help and Support window, under Pick a Help Topic, click Windows basics. 

In the left pane, click to expand Core Windows tasks. 

Click Searching for information. 

In the right pane, under Pick a task, click Get information about your computer. 

In the right pane, under What do you want to do?, click View a list of Microsoft software installed on this computer. 

The list can be copied and pasted into another document. 

Back to the Original (DG)

We've all done it.  At some time or another we've all inserted a picture into a document, worksheet or presentation and started altering its appearance. Let's make it larger... no smaller... no wait, we'll stretch it only vertically. And let's lighten the colors and crop it a bit over here. Next thing you know you've got a mess and you're looking at the undo button thinking "How far back do I have to go to fix this one?". Or maybe you figured that it would be faster to delete the destroyed picture and re-insert the original.

Both of these ideas work but there's a quick and easy one button solution to your problem. Interested in the "how to"?

Yeah, I thought you might be.

When you have a picture selected the Picture toolbar should open. If it doesn't don't panic!

Try a right click on the picture and choose Show Picture Toolbar from the menu or use the View menu, Toolbars submenu, Picture choice.

At any rate, once the toolbar is open you're only one button away from a reset of the picture to its original state.

The button you're looking for is on the far right end—the Reset Picture button.

Click it and Poof! Your picture is restored no undo or re-insertion required.

As you're browsing Web pages with Internet Explorer, you may come upon some sites that offer graphic images for downloading, for example ... Dave "Bytes". You can save Web graphics on your computer hard drive in one of the following three ways:

As a graphic file for viewing and printing in the My Pictures folder.

To do this, right-click the graphic and then click Save Picture As on the image shortcut menu.

As the wallpaper for your desktop. 

To do this, right-click the graphic and then click Set as Background on the image shortcut menu.

As a Desktop item that appears on your computer desktop. 

To do this, right-click the graphic and then choose Set as Desktop Item on the image shortcut menu.

Note that if you save a Web graphic as the wallpaper for your desktop, you have a choice between tiling the image (that is, duplicating it across the entire desktop), centering it in the middle of the desktop, or stretching it so that it fills the entire desktop (which most often results in a severely distorted image). 

Also note that some Web graphics (photographs and works of original art, usually) are copyrighted, and Web designers do have a way to disable your right click function while you're surfing their Web sites.

How to Rename a Series of Files (DG)

If you have a series of files you want to rename, but want to keep the sequence intact, here's how:

Using Windows Explorer, locate the files. Be sure you're in "Details" mode.

Go to the last file in the sequence and select it.

Hold down the Shift button and select the first file in the sequence.

All the files should now be highlighted.

Go to File/ Rename. You should now be able to rename the first file. Be sure to keep the file extension. All the files should now be renamed in sequence with the new appellation.

Shortcut Labels (DG)

The solid box behind a shortcut label can be very annoying, especially if you have dozens of icons on your desktop.

It doesn't take much to change this. 

Right-click "My Computer" and choose Properties (or hold down Alt & double left-click "My Computer") to bring up the Systems Properties window. 

Select the "Advanced" tab. 

Under "Performance" click the "Settings" button. This will bring up the Performance Options window. 

Under the "Visual Options" tab, click the "Custom" radio button. You'll see a list of check boxes. Check off the one that says, "Use drop shadows for icon labels on the desktop". 

Then "Apply" or "OK" to make the change. 

When you go back to your desktop the labels should be clear. Now you can see your wallpaper better.

Turning Off Your Computer (DG)

Choose the Turn Off option when nobody else will be using the computer until the next morning. Windows XP saves everything, and tells you when it's okay to turn off your computer. (Sometimes it turns it off for you.) When you choose Turn Off Computer, Windows clings like a sleepy cat, tossing up these three options: 

Standby: Also called Hibernate on some laptops, this option quickly saves all your work and puts the computer in virtual sleep -- a delicate mode between on and off. Avoid it. 

Turn Off: Choose this option when you're done for the day. Let you -- and your computer -- get some real sleep. When Windows XP leaves the screen, turn off the computer and the monitor, if Windows XP doesn't do it automatically. 

Restart: Only choose this option when Windows XP screwed something up: Several programs crashed, or Windows seems to be acting awfully weird. Windows XP turns off and reloads itself, hopefully feeling refreshed. 

When you tell Windows XP that you want to quit, it searches through all your open windows to see whether you've saved all your work. If it finds any work you've forgotten to save, it tosses a box your way, letting you click the OK button to save it. Whew! 

You don't have to shut down Windows XP every night. In fact, some people leave their computers turned on all the time, saying it's better for their health. Others say their computers are healthier if they're turned off each day. However, everybody says to turn off your monitor when you're done working. Monitors definitely enjoy cooling down when not being used. 

Media Player (DG)

Although Media Player blew it badly by not being able to create MP3 files, at least it plays them. To listen to an MP3 file — whether you downloaded it from the Internet or created it with a different program — follow these steps: 

Open Media Player. 

If you don't see its icon on your desktop or near your Start button, click on the Start button, choose Programs, and click on Windows Media Player from that menu. 

Choose Open from the File menu. 

The Open box appears, ready for you to root through your folders for the appropriate file. 

Locate your MP3 file. 

Open the folder that holds your MP3 file. 

Having trouble finding your MP3 file? Then choose Search from the Start menu, choose For Files or Folders, and type *.mp3 into the box called Search for files or folders named.

Click on the Search Now button, and all your MP3 files appear in the Search Results window. Double-click on the MP3 file you want to hear. Media Player immediately begins playing the song. 

Media Player lets you create playlists of your favorite tunes. 

To hear several MP3 songs in a row, hold down Ctrl while clicking on MP3 files. Then, when you click on the Open button, Media Player plays all the selected files. 

Although Windows Media Player does a decent job of playing MP3 files, the program's just too huge. For a more versatile and slim player, check out WinAmp. 

Mouse Tip (DG)

If you're using a wireless optical mouse then get a white or light-colored mouse pad. The mouse's infrared transmitter/receiver uses less power if it's reading a light-colored surface. This will make your batteries last longer. 

 SEQ CHAPTER \h \r 1Windows XP's Picture and Fax Viewer

Kathy Frey, Computer Club of Green Valley, Arizona

Windows XP has a picture viewer that is a great way to view your digital photos.  First, locate a folder with a digital photo file on your computer.  Then right click the photo, select open with, and choose the Windows Picture and Fax Viewer.  You can use the Next and Previous buttons to view other photos in the same folder.

In the Windows Picture and Fax Viewer, you can view the photos one by one or in a slide show.  Other things you can do include rotating the image clockwise and counterclockwise, zooming in and out, and printing.

If you print through the Windows Picture and Fax Viewer, you have the option of printing multiple pictures on a page.  Just follow the printing wizard. When you come to the layout selection window, you use the scroll bar to choose anything from one image on a page to as many as 35 images per page.  You do not need to buy special photo editing software to print multiple photos on a page.

If you want to edit a photo, click the icon at the bottom right of the Viewer tool bar.  This will open your default photo editor, such as Photoshop Elements or Picture It.  If you don't have a default image editor, the file will open in Paint.  And it's all included in XP

 SEQ CHAPTER \h \r 1Inkjet Printer Care

Kathy Frey, Computer Club of Green Valley

If you are leaving for the summer months, take care of your printer before you leave.  Printers should not sit for months with the ink cartridges left installed in the printer.  Consult your printer manual for proper removal.

Even if you just installed a new cartridge, you will need to remove it.  Wrap the cartridge tightly, with either or a combination of Saran wrap, aluminum foil, and a resealable plastic bag.  Remove as much air as possible from the packaging.  Store in the vegetable compartment of your refrigerator.  The vegetable compartment has some moisture which will help keep the cartridge from drying out.

There is no guarantee that the cartridges will not dry out and therefore be unusable.  However, taking precautions before you leave may save you the cost of purchasing a new cartridge.

 SEQ CHAPTER \h \r 1CRT and Flat-screen Monitor Care

Kathy Frey, Computer Club of Green Valley

Use extreme care when cleaning your monitor's screen as the surface can be easily scratched.  Never touch your monitor LCD screen with your finger nails.  For cleaning use a soft and dry lint-free cloth to remove dust and greasy fingerprints from the screen.  Do not use polish or glass cleaner on your monitor.  Many modern displays have anti-glare coatings that are easily damaged.

Various  SEQ CHAPTER \h \r 1Windows Tips 

Larry Smith, Big Bear Computer Club, CA 

Rush hour on the Windows Taskbar
If your Taskbar is too full to read individual items, position your mouse pointer on top of the Taskbar until you see a double-headed arrow.  Left click and drag upwards to make room for all those open windows.

Window cleaner (98/XP)
Need more room to view Web and program pages?  Right click the Taskbar (center section at bottom of screen) and choose Properties.  Uncheck "Always on top."  Now you can drag any page to the screen's bottom.  And drag it back up.

Windows speed trap

To determine your dial-up speed, hover your mouse pointer over that little double computer icon in your system tray.

All the better to see you with
Try the Magnifier for a really big view.  Left click "Start," "Programs," "Accessories," "Accessibility," "Magnifier."

Making it easier to capitalize
If you often find it difficult to type capital letters because you have to hold down the shift key, you can turn on a feature called StickyKeys which allows you to simply tap the shift key before a letter you wish to capitalize instead of having to hold it down.  It is designed to allow typing with one hand.  To activate StickyKeys in Windows 95 or higher go to "Start" and then to either "Settings" or "Control Panel."  From there click the "Handicapped Accessibility" button and then select "StickyKeys."

No more repeated lettersssss
Designed for those with difficulty typing, Windows offers FilterKeys.  When Filterkeys are turned on, the computer will ignore brief or repeated keystrokes or slow the repeat rate.  To turn on FilterkEys go through "Start" to your "Settings" or "Control Panel."  From there click on "Handicapped Accessibility" and then select "FilterKeys."  For some Windows you can also hold down the right Shift key for 8 seconds to activate this feature.

Bypass The Recycle Bin (XP)

Delete items without sending them to the Recycle Bin by right clicking on the Recycle Bin and choosing properties, under the Global tab check “Do not move files to the Recycle Bin Remove files immediately when deleted”. Click Apply then OK. 

Create a Shortcut to Your Printer (XP)

To make it easy to access print options or stop your printer, click on “Start,” select “Control Panel”, then “Printers and Other Hardware”, then click “View installed printers or fax printers”, right click on your printer name and select “Create Shortcut”. Place shortcut on your desktop. 

Access The Start Menu Without a Mouse (XP)

Press CTRL-ESC to open the Start Menu and then use the arrows to navigate and the “Enter” key to run programs and make selections. 

Access System Properties

Press the Windows icon key and the Pause/Break key to open System Properties. This window gives you information about your computer system. Handy when online with tech support.

 SEQ CHAPTER \h \r 1Printing Without Color

Les J. Kizer,
Greater Tampa Bay PC User Group

If your printer uses too much colored ink while printing large colorful documents, such as Bay Bytes, do: / Start / Settings / Printers, then right click on the icon for your printer followed by clicking on Properties. Look for a check box that allows you to print in grey scale. Such a setting prints the document in black and white without the benefit of color.

A bunch of troubleshooting tips (DG)

Most people have heard some of these tips at some point but there should be information here that will help in many different troubleshooting situations. As always, make sure the system is off when removing or installing components inside the computer. These are in no particular order.

There are four basic rules of troubleshooting (these apply almost anywhere ? not just computers):

1. Identify the problem. What exactly is the undesired behavior.

2. Isolate the problem. Where does the fault lie. What component is defective or not performing properly.

3. Implement a solution. Repair or replace defective components. 

4. Repair or reload corrupted software.

Test the solution. Ensure that the solution corrected the fault and the problem does not continue.

The old stand by questions. Is it plugged in correctly? Is it turned on?

Keyboard and mouse cables can work their way loose. It is easy to plug the speakers into the speakerphone port on the modem instead of the speaker port on the soundcard. Check to make sure that everything is securely connected in the correct place. Make sure that the power cable is secure at the power supply and at the surge protector. Make sure the surge protector is plugged in to the wall outlet or UPS and is turned on.

Grinding or growling noises coming from the computer case are often a sign of a cooling fan failing. Try to isolate where the noise is coming from. IF it is at the back of the case near the top it is probably a power supply fan that is failing. Otherwise, it is most likely a CPU fan failing. Cooling fans are very important to the overall health of your system. Get them replaced at the first sign of trouble.

If the light on the floppy drive stays on all the time and you can't access any floppy disks, most likely the data cable from the controller to the floppy drive is connected backwards at one end.  Check the orientation of pin 1.

Periodically run a thorough scan of the hard drive. If the hard drive has bad sectors, replace it. This can catch minor problems before they become major ones and may help you prevent loss of your data.

Use the online help. Many problems encountered in Windows are covered in the online troubleshooter in the Windows help. Using the troubleshooter to eliminate software problems can help save money on unnecessary hardware repairs.

Identify ALL the details of the problem. Does the error only occur in one program or all of them? Does it only happen after the system has been running for a while or only after first turning the system on? 

Does it happen only when certain peripherals are connected? 

Knowing all the details will usually highlight the source of the fault.

Does the system not work correctly (or at all) after moving it? Double check you cables. If that doesn't solve the problem, check to make sure that no cards or memory have come unseated.

Does the system lock up after running for a while? Check the condition of the fans and heat sinks. Dust, pet hair, carpet fibers etc. can become lodged in the heat sink and fan and greatly reduce their effectiveness. Use a can of compressed air to clean out the heat sink. (Don't use a household air compressor - oil and moisture can severely damage the system.)

Remember the old axiom - if all else fails, read the manual.

When troubleshooting, only make one change at a time. If that change has no effect on the problem, change it back. Changing several things at once can make it nearly impossible to find the faulty component.

Use any resource available. 

Join the SPCUG Yahoo Group at www.spcug.org and ask if anyone else has encountered the problem before. 

Check manufacturers web sites for fixes or known bugs.

Check the device manager for resource conflicts. In the device manager, double click on Computer. This will allow you to check the actual resources. Windows allows PCI cards to share some resources and some cards may not function properly when sharing IRQs.

